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Welcome to SMARTS Annual Reports Help 

SMARTS AR (Annual Reports) Help is designed to address the functional aspects of the 
SMARTS AR program. Help information concerning Annual Reports can be accessed using the 
Contents, Index, or Search commands at the top, left-hand side of this screen. 

 The table of Contents is the default display in the left panel of this screen. Click a book 
icon to display the help topics it contains. Click a topic name to display the topic in this 
space. 

 The Index presents an alphabetical list of all help topics and index keywords. Type any 
character or text into the field at the top of the index and the term that most closely 
matches that text will automatically be selected. Click the selected index term and either a 
help topic will appear or a list of associated help topics will appear. 

 The Search command enables you to query all help topics concerning any term about 
which you would like more information. Type the desired term into the Search field and 
then click Go. All help topics are searched and only those containing the term are 
automatically listed for your selection. 

Microsoft Word® Help 

Microsoft Word Help should provide answers to any questions you have about using Word to 
work on your annual report. To access Word Help, on the Word menu bar open the Help menu 
and click Microsoft Word Help. The Microsoft Word Help dialog box appears. 

Accessing Annual Reports 

Annual Reports is a Cancer Therapy Evaluation Program Enterprise System (CTEP-ESYS) 
application accessed via the CTEP-ESYS front panel. Depending on your user access role, 
Annual Reports is accessed by either logging on to CTEP-ESYS directly or by logging on via 
CITRIX. See your system administrator or manager for access information.  

To open Annual Reports from CTEP-ESYS perform the following steps. 

1. Log on to CTEP-ESYS. 
2. On the CTEP Enterprise System front panel, click the Annual Reports button. 

The Annual Reports window appears. 

  

Related Topics: 

Annual Reports Access via CITRIX. 

User Credentials 

Troubleshooting 

Annual Reports Access via CITRIX 

Users from TRI gain access to Annual Reports by logging on via Citrix ®. 

To open Annual Reports using Citrix perform the following steps. 

1. Open Internet Explorer ® and enter the address http://ctep.ts.nci.nih.gov. 

The CTEP Citrix user Login page appears. 

2. Type your Citrix user credentials (Username, Password, and Domain). 
3. Click Log In. 

http://ctep.ts.nci.nih.gov/
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The Citrix application portal appears. 

4. Click CTEP Enterprise Application - TRI. 

A Logon dialog box for the CTEP Enterprise System (CTEP-ESYS) appears. 

5. Type your CTEP-ESYS user credentials (Username, Password, and Database). 

The CTEP  ESYS front panel appears. 

6. Click Annual Reports. 

The Annual Reports window appears. 

  

Related Topics: 

Accessing Annual Reports 

User Credentials 

Troubleshooting  

User Credentials 

Information you'll need for access to Annual Reports. 

  

Citrix ® 

 Username: Use your local TRI user name. 

 Password: Use your local TRI password. 

 Domain: ncitri 

  

CTEP Enterprise System 

 Username: Use your CTEP-ESYS Login ID. 

 Password: Use your CTEP-ESYS Password. 

 Database: ctepesysprod 

  

Related Topics: 

Accessing Annual Reports 

Annual Reports Access via CITRIX 

Troubleshooting 

  

Troubleshooting 

Messages concerning the log on process may appear in the Citrix ® Message Center. A brief 
description and possible solution for some common error messages are listed below: 

  

 You do not have the Citrix ICA CLient (AciveX) for 32-bit Windows installed on your 
system. You must install the ICA Client to launch the applications. 
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The Citrix Client was not installed on your machine or the install was not successful. If you 
see this message contact your help desk.  

 ERROR: The MetaFrame server farm reported that the Credentials entered were incorrect. 

Your user credentials (Username, Password, or Domain) entered on the CTEP Citrix 
user Login page are incorrect. Verify your user credentials and try again. 

 ERROR: Your session with the web-server expired. You have been logged out. 

Your session with Citrix has expired due to inactivity. You will have to log on again. 

  

Related Topics: 

Accessing Annual Reports 

Annual Reports Access via CITRIX 

User Credentials 

  

Accessing Microsoft Word Help 

Microsoft Word Help should provide answers to any questions you have about using Word to 
work on your annual report. To access Word Help, on the Word menu bar open the Help menu 
and click Microsoft Word Help. The Microsoft Word Help dialog box appears. 

  

Related Topics: 

Contacting the CTEP Help Desk 

Contacting the CTEP Help Desk 

If you encounter problems while working with SMARTS Annual Reports please contact the CTEP 
Help Desk by sending an email, with a detailed description of the problem, to 
ctephelp@ctisinc.com 

  

Related Topics: 

Accessing Microsoft Word Help 

About SMARTS Annual Reports 

Annual reports containing clinical trial data and information concerning specific Investigative New 
Drugs (IND) are created for submittal to the National Cancer Institute (NCI) Cancer Therapy 
Evaluation Program (CTEP), Investigational Drug Branch (IDB) and the Food and Drug 
Administration (FDA).  

An annual report is a Microsoft® Word document comprised of many sections with each section 
designed to present unique information about any selected IND. The Scientific Management of 
Agents Reporting and Tracking System (SMARTS) Annual Reports application enables you to 
create, update, review, and generate annual reports. For more information see the following 
topics. 

  

mailto:ctephelp@ctisinc.com
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Related Topics: 

About Creating an Annual Report 

About Editing an Annual Report 

About Completing an Annual Report 

SMARTS Annual Reports Version History 

  

Version 
Number 

Release 
Number 

Date Release Notes 

3 NA 03/14/2003 Production 

3 2 07/04/2003   

3 3 07/31/2003   

3 4 08/07/2003   

3 5 09/25/2003   

3 7 05/28/2004   

3 8 08/26/2004   

3 9 04/11/2005   

3 10 07/13/2005 SMARTS AR v3 r10 Release Notes 

4 1 09/29/2006 SMARTS AR v4 r1 Release Notes 

        

        

   

About SMARTS Annual Reports System Requirements 

The Scientific Management of Agents Reporting and Tracking System (SMARTS) Annual Reports 
application uses automated processes for the creation and maintenance of Annual Reports. 
Certain system requirements must be adhered too so that these automated processes function 
correctly. For more information see the following. 

System Requirements for Annual Reports 

Permitting Macro Execution by Microsoft Word 

Accessing Annual Reports 

../../../d_new_smartsar/SMARTS%20Annual%20Reports/Content/smarts_3.0_r10_release_notes.pdf
../../../d_new_smartsar/SMARTS%20Annual%20Reports/Content/SMARTS%20%20AR%20v4%20r1%20Release%20%20Notes.pdf
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Permitting Macro Execution by Microsoft Word 

Most of the SMARTS Annual Reports application features and functions are driven by macros. To 
function correctly the Annual Reports application requires that Microsoft® Word is appropriately 
enabled to run macros. To enable macro execution by Word do the following when necessary. 

Macro Security 

If a Re Run message appears while you are logging on to Annual Reports, perform the following 
steps to change your macro security settings for Word. 

 

1. Open Microsoft Word. 
2. From the Tools menu click Macro, then select Security. 
3. Click the Security Level tab, then select Medium and click OK. 

Enabling Macros 

When you begin creating an annual report a macro warning appears. Click Yes to enable the 
correct functioning of Annual Reports.  

 

If you click No to prevent the macros from running, the Annual Reports application will not 
function properly.  

System Requirements for Annual Reports 

To ensure that the Annual Reports application performs correctly the following system 
requirements must be met. 

 Availability of Annual Reports templates: The AnnualReports.dot and 
ARAddEditSection.dot templates are necessary so that the Annual Reports application can 
correctly function within Microsoft Word. The Annual Reports application automatically 
copies these templates to your computer's local drive. If these template files are 
inaccessible or not present an error message is displayed. If this occurs then contact the 
CTEP Help Desk. 
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 Local drive read/write permission: The Annual Reports application creates temporary 
files and updates local versions of Section documents (used as format templates in 
reports) as a normal part of the report generation process. For this purpose, it is required 
that you have read/write permission for the local drive used by the application. After 
successfully connecting to the shared network data resource, the Annual Reports 
application determines whether you have read/write permission. If you do then a 
confirmation message is displayed. If you do not have read/write permission for this drive 
then an error message is displayed. If this occurs then contact your System Administrator. 

 

 

 Valid file name and directory path: When ever you open or save any annual report file 
the Annual Reports application validates that a correct file name and directory path are 
used. If you enter an invalid file name or directory path then an error message is displayed. 
If this occurs check to ensure that you have correctly entered the file name. 

 
 Must be a Word document: All document files created, opened, or saved in the Annual 

Reports application must be Word documents. If the file name extension is not .doc, then 
an error message is displayed. If this occurs ensure that you have access to Microsoft 
Word on your computer. 

 

  

About Creating Annual Reports 

The Annual Reports application provides four distinct methods for creating an annual report. 
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 Creating an Annual Report by Using the Wizard: Annual Reports was designed around 
this method. The Annual Reports Wizard automates much of the report writing process. 
The Wizard prompts you to specify the IND and the report sections that you want included 
in the report and then generates a report document based on your responses. The report 
document opens in Microsoft Word and information from the appropriate annual report 
libraries is automatically populated. Finally edit (specify dates for select tables and insert 
information into areas where the application was unable too) and complete the report to 
ensure it is ready to be sent, and archived. 

 Creating an Annual Report from an Archived Annual Report: An archived annual 
report for an IND can be used as the basis for creating a new report for the same IND. 
When you attempt to create a new annual report the application will give you the option to 
access an archived annual report for the same IND. Once the archived report is displayed, 
you simply update and edit the existing information. 

 Creating an Annual Report from a Similar Annual Report: When you are creating a 
new annual report that will be substantially similar to an existing annual report for a 
different IND, it may be easiest to open the existing report, change the IND, and then 
update and edit the appropriate information. In a sense, you are using the existing report of 
one IND, as a very detailed report template for another IND. 

 Creating an Annual Report without Using the Wizard: This method is used only when 
you have very specific reporting needs. This is the most labor-intensive of the methods 
offered and involves selecting sections, tables, and text one-by-one from the respective 
annual report libraries. 

Once an Annual Report has been created using any of the methods described above you must 
edit and then complete the resulting document before it is ready to be sent. For more information 
see the following topics. 

  

Related Topics: 

About Editing an Annual Report 

About Completing an Annual Report 

Creating an Annual Report by Using the Wizard 

The Annual Reports Wizard automates much of the report creation process and generates a 
report document based on the responses you make during the process.  

Note: For important information concerning macro settings see Permitting Macro Execution by 
Microsoft Word. 

To create an annual report by using the Annual Report Wizard 

1. On the Annual Reports window, click Create New and then OK. 

Microsoft Word opens with a message asking if you would like to open a document with it's 
attached macros running. 

2. Click Yes, and the Annual Report Wizard appears. 
3. In the Select an IND field, enter the IND for which the report is being created. 

The remaining fields automatically populate with information concerning the selected IND. 

4. Click Next. 

If an annual report for the selected IND was previously generated and archived, a 
message appears asking if you want to retrieve that report. 

5. Click No. 
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The Select Sections field appears displaying the names of section templates available for 
inclusion in the report. 

Note: In the Select Sections field, some sections are automatically selected based on 
whether or not the IND is a biologic or chemotherapeutic. 

6. In the Select Sections field, ensure that the name of those sections you want to appear in 
the report are selected. 

7. Click Finish. 

The draft annual report appears, ready for your editing and completion. 

8. If necessary edit the report (see About Editing an Annual Report). 
9. Perform the report's completion process as described in About Completing an Annual 

Report. 
10. Save the report.  

  

Related Topics: 

About Creating an Annual Report 

Saving an Annual Report 

Creating an Annual Report from a Similar Annual Report 

You can create an annual report for an IND by using an existing annual report of a different IND 
as a template. 

To create an annual report from a similar report 

1. On the Annual Reports window, click Open Existing and then in the adjacent field enter 
the path of the report you want to open and use as a template. 

2. Click OK. 

Microsoft Word opens with a message asking if you would like to open a document with it's 
attached macros running. 

3. Click Yes. 

The annual report document appears. 

4. On the Report Generator menu (on the Word toolbar), click Assign IND. 

The Assign IND to Document dialog box appears. 

5. In the Select an IND field, type or select the number of the IND for which the report is 
being creating . 

The IND Title field automatically populates. 

6. Click Assign. 

Note: You will see no apparent change to the opened annual report document, but the 
information contained in all of the Annual Reports Libraries is now associated with the 
newly assigned IND.  

7. Edit the report to include the appropriate information (see About Editing an Annual Report). 
8. Perform the report's completion process as described in About Completing an Annual 

Report. 
9. Save the report.  

  

Related Topics: 
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About Creating an Annual Report 

Saving an Annual Report 

Creating an Annual Report from an Archived Annual Report 

When a previous year’s annual report for an IND exists, it can be used as the basis for creating 
this year’s report concerning the same IND. 

Note: This method of creating a subsequent year’s annual report is only available when a 
previous annual report for the IND has been prepared for FDA submission and archived. 

To create an annual report from an archived report 

1. On the Annual Reports window, click Create New and then OK. 

Microsoft Word opens with a message asking if you would like to open a document with it's 
attached macros running. 

2. Click Yes. 

The Annual Report Wizard appears. 

3. In the Select an IND field, enter the IND for which the report is being creating. 

The remaining fields automatically populate with information concerning the selected IND. 

4. Click Next. 

If an annual report for the selected IND was previously generated and archived, a 
message appears asking if you want to retrieve that report. 

5. Click Yes. 

The last archived annual report for the selected IND appears (replacing the Annual Report 
Wizard) and is ready for your editing and completion.  

6. Make any necessary changes to the report (see About Editing an Annual Report). 
7. Perform the report's completion process as described in About Completing an Annual 

Report. 
8. Save the report.  

  

Related Topics: 

About Creating an Annual Report 

Saving an Annual Report 

Creating an Annual Report without Using the Wizard 

Annual reports can be created without using existing reports as templates and/or without the 
assistance of the Annual Report Wizard. When using this method all of the Annual Reports 
application Libraries are available from the Word toolbar to insert IND specific sections, tables, 
and data. To create a new annual report without using the annual report wizard perform the 
following steps. 

1. On the Annual Reports window, click Create New and then OK. 

Microsoft Word opens with a message asking if you would like to open a document with it's 
attached macros running. 

2. Click Yes. 
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The Annual Report Wizard appears. 

3. Click Cancel. 
4. On the Report Generator menu (on the Word toolbar), click Assign IND. 

The Assign IND to Document dialog box appears. 

5. In the Select an IND field, type or select the number of the IND for which the report is 
being created. 

The IND Title field automatically populates. 

6. Click Assign. 

The Annual Reports Libraries (Data Library, Table Library, Section Library, and Special 
Library) appear on the Word toolbar and a draft annual report is ready to edit. 

7. Edit the report to include the appropriate information (see About Editing an Annual Report). 
8. Perform the report's completion process as described in About Completing an Annual 

Report. 
9. Save the report.  

  

Related Topics: 

About Creating an Annual Report 

Saving an Annual Report 

Designating Protocol Trial Types 

A Trial Type indicates whether a protocol uses a single agent or a combination of multiple agents. 
When you open or create an annual report, all protocols associated with your selected IND are 
checked to see if they have an assigned Trial Type. If one or more protocols associated with the 
IND do not have an assigned Trial Type, then an Invalid Trials message appears and the annual 
report is not generated. The Annual Reports application provides you with the means to assign 
Trial Types to protocols when necessary. 

To assign Trial Types to protocols perform the following steps. 

1. When an Invalid Trials message appears click OK. 
2. Return to the Annual Reports window, and click Trial Designation. 

The Protocol Trial Type Maintenance screen appears. 

3. Type the desired IND identification number into the IND Number field. 
4. Enter the appropriate value into the IND Prefix field. 

5. On the Toolbar, click Execute Query  . 

Information concerning your queried IND appears in the IND Information area, and all 
protocols associated with that IND appears in the Protocols area. All protocols are sorted 
by Trial Type and Protocol Number. Those without a Trial Type are at the top of the list. 

Note: Only protocols having a Current Status of Active, Temporarily Closed to Accrual,  
Temporarily Closed to Accrual and Treatment, Closed to Accrual, and Closed to Accrual 
and Treatment are displayed.  

6. Ensure that all protocols have an appropriate value entered into the Trial Type field. 
7. Save your changes. 

Note: Once your query results appear you can use Previous Record  and Next Record  
to review information concerning other IND's. 
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Related Topics: 

About Creating Annual Reports 

Opening an Existing Annual Report  

About Annual Report Section Templates 

An annual report section template is a named section document which, when incorporated into an 
annual report, provides a format for a specific type of information concerning any IND for which 
the annual report was created. These named section templates (section documents) are 
comprised of text and/or tables formatted to best accommodate the information to be displayed in 
that section. Many of these section templates include macros which automatically populate the 
latest updated data whenever the reports are generated.  

When an annual report is created all of the section templates selected for that report are 
automatically integrated into the report by the Annual Reports application.  

Note: The AnnualReports.dot and ARAddEditSection.dot files mentioned in System 
Requirements for Annual Reports and used by the Annual Reports application are true Word 
templates that should not be modified.  

After an annual report has been generated by the application, you can make changes to the 
content and format of any section in the report. However, these changes affect only that individual 
report and have no bearing on the section templates used by the application to generate any 
other report. 

You can make changes to individual annual report section templates directly and then these 
changes will appear in or be available for all annual reports generated by the application 
thereafter. For specific instructions about changing or creating section templates see the Related 
Topics below.  

Note: Administrator permission is required before altering an annual report section template 
(section document). 

  

Related Topics: 

Creating a Section Template 

Editing a Section Template 

Creating a Section Template 

New annual report section templates (section documents) can be created and added to the list of 
section templates that are available for use in individual IND annual reports.  

Note: Administrator permission is required before altering annual report section templates. 

To create a new section template 

1. On the Annual Reports window, click Create New and then OK. 

Microsoft Word opens with a message asking if you would like to open a document with it's 
attached macros running. 

2. Click Yes. 
3. In the Annual Report Wizard, click Cancel. 
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A blank Word document opens and three Annual Reports menus (Report Generator, 
Administration, and Options) appear in the tool bar. 

4. On the Administration menu, click Add New Section Template. 

A second blank Word document opens and the following Annual Reports menus appear on 
the tool bar. 

Section Generator 

Data Library 

Table Library 

Special Library 

5. In the document, type the desired section heading (formatted to be consistent with other 
annual report section headings) and other appropriate textual information. 

6. Place the cursor were you want other text or tables to be automatically inserted during 
Annual Report generation and then select the desired text or table from the Data Library, 
Table Library, or Special Library menus. 

A field or bookmark representing your selection appears at the desired location. Repeat 
this step as often as necessary. 

7. On the Section Generator menu, click Save Section to Database. 

The Save Section dialog box appears. 

8. In the Document Name field, type the desired file name for the new section template 
(because this is a Word document include .doc).  

9. In the Display Name field, type the name of the section. 

Note: In the Version field the number one is displayed. Do not change this value. 

10. In the Insert After field, enter the name of the section you want preceding the new section 
in the Annual Reports Wizard list of sections. 

11. In the Format area, click Portrait or Landscape to indicate the page orientation of the 
new section. 

12. In the Type area, click Biologic, Chemo, Neither, or Both to indicate the type of IND for 
which the new section is available. 

Note: In the First/Subsequent Queried Section area, No is selected. Do not change this 
selection. 

13. Click Save. 

The new section is added to the list of available section templates. All annual reports that 
are generated, will include this section for the specified IND type. 

  

Related Topics: 

About Annual Report Section Templates 

Editing a Section Template 

Existing annual report section templates (section documents) can be edited and after the edited 
template is saved the changes will appear when any report containing those sections is 
generated.  

Note: Administrator permission is required before altering annual report section templates. 

To edit a section template 
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1. On the Annual Reports window, click Create New and then OK. 

Microsoft Word opens with a message asking if you would like to open a document with it's 
attached macros running. 

2. Click Yes. 
3. In the Annual Report Wizard, click Cancel. 

A blank Word document opens and three Annual Reports menus (Report Generator, 
Administration, and Options) appear in the tool bar. 

4. On the Administrator menu, click Edit Section Template. 

The Edit Section dialog box appears. 

5. In the Choose Section to Edit field, enter the name of the section template you want to 
edit and then click Edit. 

The selected section template Word document opens and the following Annual Reports 
menus appear on the tool bar. 

Section Generator 

Data Library 

Table Library 

Special Library 

6. Make desired changes to the existing document content (text or tables). 
7. If necessary place the cursor were you want additional text or tables to be automatically 

inserted during Annual Report generation, and then select the desired text or table from 
the Data Library, Table Library, or Special Library menus. 

A field or bookmark representing your selection appears at the desired location. Repeat 
this step as often as necessary. 

8. On the Section Generator menu (on the Word toolbar), click Save Section to Database. 

The Save Section dialog box appears. 

9. Ensure that all fields and options in the Save Section dialog box are correct for your 
changes. (For more information see Creating a Section Template). 

10. Click Save. 

  

Related Topics: 

About Annual Report Section Templates 

About Editing an Annual Report 

When an annual report is created information (document formatting, textual content, data) is 
automatically inserted by the Annual Reports application. Because the application requires you to 
modify some of the automatically inserted information (see About Editing Text in an Annual 
Report) any annual report you create must be edited to ensure that the correct information is 
displayed in the report. Before you start editing consider the following. 

 Document Formatting: Click the Show/Hide button  on the standard toolbar to 
ensure that document formatting marks are displayed. This helps you avoid changing 
document formatting unintentionally and makes it easier to select any formatting 
characteristics that you do want to change. 
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 Bookmarks: Bookmarks mark the location of tables or text that are automatically placed 
within an annual report document. On your screen bookmarks appear in the document as 

brackets ([…]) or an I-beam. These marks do not print. When you edit a report bookmarks 
must be displayed so that you do not inadvertently delete them. On the Options menu 
click Hide/Show Bookmarks. Remember that if you make changes to tables or text inside 
a set of bookmarks the changes will be undone when you later update the annual report. 

 Fields: Annual report text enclosed in a grey background represent Word fields 
automatically placed within the document. Fields indicate text or data that is automatically 
inserted when a report is created or updated, or may ask you to type specific information at 
that location. Do not delete or type in a field unless it specifically asks you do so. For more 
information see Working with Green-Colored Text. 

  

Information that can be inserted into an annual report is stored in and accessible from one of four 
Annual Reports Libraries described below. During the annual report editing process these 
libraries, accessible from the Word toolbar, make it easy for you to add, modify, or update annual 
report information. 

 Data Library: A list of named blocks of text that can be inserted into an annual report.  

 Section Library: A list of formatted annual report sections that can be inserted into a 
report. 

 Table Library: A list of previously created data specific tables that can be inserted into a 
report.  

 Special Library: A list of specially formatted information that can be inserted into a report. 

All of the items listed in the libraries are Word documents whose content is indicated by the name 
of each item. Many of the library documents contain fields or bookmarks that automatically insert 
or update specific types of data.  

  

Related Topics: 

About Annual Report Sections 

About Annual Report Tables 

About Editing Text in an Annual Report 

Using Page and Section Breaks 

Opening an Existing Annual Report 

To open an existing annual report perform the following steps. 

1. On the Annual Reports window, click Open Existing and then type or select the path of 
the report you want to open. 

2. Click OK. 

Microsoft Word opens with a message asking if you would like to open a document with it's 
attached macros running. 

3. Click Yes. 

The selected annual report document appears. 

  

Related Topics: 

About SMARTS Annual Reports 

About Editing an Annual Report 
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Using Page and Section Breaks 

Page breaks are inserted into annual report documents to ensure that specific report sections 
begin at the top of a new page. For example, a page break is automatically inserted after the 
table of contents so that the following section begins at the top of the next page. 

Section breaks are inserted into annual report documents when a change of section formatting 
is needed. Section breaks can be used to change the formatting in the middle of a page or to start 
different formatting on a new page. In an annual report, section breaks are commonly used to 
accommodate tables that need a landscape page orientation. 

Editing, moving, or adding sections in an annual report may result in unnecessary or misplaced 
page or section breaks creating  blank pages. You can add, delete, or move page and section 
breaks to correct this but to do this you must be able to see where they are located in the 
document. In an open annual report the following actions can be taken. 

 To see page and section breaks click the Show/Hide button  on the standard toolbar 
to ensure that document formatting marks are displayed.  

 To delete a page or section break select the formatting mark of the desired break and then 
press DELETE. 

 To add a page or section break: 
1. In the annual report, place the insertion point where you want a page or section 

break. 
2. From the Insert menu, choose Break. 
3. Select the type of page or section break you want to add and then click OK. 

  

Related Topics: 

About Editing an Annual Report 

Opening an Existing Annual Report 

About Annual Report Sections 

An annual report is divided into named sections each of which is formatted to accommodate a 
specific type of information concerning the IND for which the report is created. When using the 
Annual Report Wizard to create a draft report, sections to be inserted are automatically selected 
based upon whether the IND is biologic or chemotherapeutic.  

During the annual report creation process you can change which sections are inserted into the 
draft report (see About Creating an Annual Report). You can also add or delete report sections 
after the draft report has been created. See the Related Topics below for more details. 

Note: Adding or deleting sections from an existing annual report will not change which sections 
the Annual Reports application automatically select's for insertion when generating future reports. 
To permanently modify the section templates available for use in this process see About Annual 
Report Section Templates. 

  

Related Topics: 

Adding an Annual Report Section 

Deleting an Annual Report Section 
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Adding an Annual Report Section 

The Annual Reports application uses previously created section templates to automatically insert 
formatted sections into newly created reports. You can also use these section templates to insert 
additional sections into an existing report.  

Note: To avoid unintentional changes it is recommended that you display document format marks 
and bookmarks before starting the editing process. For details see About Editing an Annual 
Report. 

To insert a section 

1. Open the desired annual report (see Opening an Existing Annual Report). 
2. Ensure that the Annual Reports Libraries toolbar is displayed (if necessary refer to 

Microsoft Word Help). 
3. In the annual report document place the insertion point where you want to insert the 

section. 
4. On the Section Library menu, click the name of the desired section. 

The selected section (and any included text or tables) appears in the annual report. 

Note: Formatted page and section breaks contained in the added section may be 
integrated into the report imperfectly and may need to be moved or deleted. For more 
information see Using Page and Section Breaks. 

  

Related Topics: 

About Annual Report Sections 

Deleting an Annual Report Section 

Deleting an Annual Report Section 

To delete a section from an annual report perform the following steps. 

Note: To avoid unintentional changes it is recommended that you display document format marks 
and bookmarks before starting the editing process. For details see About Editing an Annual 
Report. 

1. Open the desired annual report (see Opening an Existing Annual Report). 
2. Select the text and formatting marks of the report section you want to delete. 
3. Press Delete. 
4. Save the report.  

  

Related Topics: 

About Annual Report Sections 

Adding an Annual Report Section 

About Annual Report Tables 

Tables used repeatedly in annual reports are stored in the Table Library. The Table Library can 
be used to select and then insert tables into existing or draft annual reports. After being inserted 
into a report some tables require that you specify a date range (see Generating Date Parameter 
Tables) from which data is drawn for display in the table. Therefore, before a draft annual report 
is ready to be completed and sent you must edit the report to ensure that all appropriate tables 
are present and contain the correct information. 
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You can edit the textual content of annual report tables directly by using a combination of Word 
tools and tools provided by the Annual Reports application for this specific purpose. For more 
information see the Related Topics below. 

Note: To avoid unintentional changes it is recommended that you display document format marks 
and bookmarks before starting the editing process. For details see About Editing an Annual 
Report. 

  

Related Topics: 

Generating Date Parameter Tables 

Editing a Table 

Inserting a Table 

Moving a Table 

Updating a Table 

Displaying Table Statistics 

Listing Updated Clinical Trials 

Displaying Table Statistics 

Displaying the table statistics of an open annual report allows you to determine the time and date 
a table or special section was last updated by the application. 

To display table statistics, on the Options menu click Report Statistics. When you are done 

reviewing the information click Close  to return to the report. 

  

Related Topics: 

About Annual Report Tables 

About Editing Text in an Annual Report 

Editing a Table 

In an annual report the textual content and format of any table can be edited directly by using a 
combination of Word tools and tools provided by the Annual Reports application for this specific 
purpose.  

Note: In your annual report, bookmarks indicate the locations of automatically inserted tables. To 
avoid unintentional changes it is recommended that you display document format marks and 
bookmarks before starting the editing process. For details see About Editing an Annual Report. 

The textual contents of a table can be edited just like the text in your annual report. After creating 
or opening an annual report some of the actions you can take to edit any tables in the document 
are listed below. 

 Change the size of table columns and rows by dragging their boundaries until the desired 
size is achieved.  

 Delete columns, rows, or cells by selecting them and then from the Table menu (on the 
Word menu bar) select Delete, and choose either Column, Row, or Cell. 

 Clear the contents of columns, rows, or cells by selecting them and then press Delete. 

 Add information by placing the insertion point at the desired location in the table and then 
type the desired text. 
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 Make the table columns automatically fit the contents by placing the insertion point in the 
table and then from the Table menu select AutoFit and choose AutoFit to Contents. 

For more detailed information concerning the above actions and other methods of table editing 
see Microsoft Word Help. 

Note: For tables having bookmarks ([...]) any modifications made will be undone if the table is 
later updated (see Updating a Table). For this reason, editing tables directly in a report should 
only be done after all automated updates have been made and the report is being completed for 
submission. 

  

Related Topics: 

About Annual Report Tables 

About Editing Text in an Annual Report 

Generating Date Parameter Tables 

An Annual Report can include tables that do not appear until you generate the tables using 
specific date parameters. This is applicable to the Patient Deaths, Expedited Adverse Events, 
and Patient Dropouts tables.  

To generate tables requiring date parameters 

1. Open the desired Annual Report (see Opening an Existing Annual Report) and ensure that 
it contains a table requiring date parameters (Patient Deaths, Expedited Adverse Events, 
and/or Patient Dropouts). 

2. On the Report Generator menu, click Enter  Table Dates. 
3. In the Table Dates dialog box, select the Update checkbox for each table you want to 

generate. 

Note: The date parameters used for generating tables in the latest archived report are 
displayed in Previous Year’s From Date and Previous Year’s To Date. 

4. For each table, type the desired date parameters into the From Date and To Date text 
boxes. 

5. Click Update. 

Word will generate and then insert the tables into your report. 

  

Related Topics: 

About Annual Report Tables 

Displaying Table Statistics 

Inserting a Table 

To insert a table into an existing or draft annual report perform the following steps. 

1. Open the desired annual report (see Opening an Existing Annual Report). 
2. Ensure that the Annual Reports Libraries toolbar is displayed (if necessary refer to 

Microsoft Word Help). 
3. In the report, place the insertion point where you want the table. 
4. On the Table Library menu, click the name of the desired table. 

The selected table appears in the annual report. 
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5. On the Reports Generator menu, click the Enter Table Dates command if necessary to 
generate tables that require date parameters (see Generating Date Parameter Tables).  

  

Related Topics: 

About Annual Report Tables 

Inserting a Table to Replace an Existing Table 

Inserting a Table while Keeping an Existing Table 

Inserting a Table to Replace an Existing Table 

While editing a table in an annual report, instead of modifying or fixing undesirable changes made 
earlier, it may be easier to replace the existing table, with the same named table from the Table 
Library.  

Note: In your annual report bookmarks indicate the locations of automatically inserted tables. To 
avoid unintentional changes it is recommended that you display document format marks and 
bookmarks before starting the editing process. For details see About Editing an Annual Report. 

To insert a replacement for an existing table 

1. Open the desired annual report (see Opening an Existing Annual Report). 
2. Ensure that the Annual Reports Libraries toolbar is displayed (if necessary refer to 

Microsoft Word Help). 
3. Place the insertion point inside the existing table you are replacing. 

Note: If the existing table is without bookmarks ([...]) then the table is not linked to the 
Table Library and cannot be automatically replaced per these steps. You must delete the 
existing table before inserting the replacement (see Inserting a Table). 

4. On the Table Library menu click the name of the table you are replacing. 

Note: Ensure that the table selected in the Table Library is the same as the one in which 
you have placed the insertion point. 

The existing table is replaced. 

  

Related Topics: 

About Annual Report Tables 

Inserting a Table 

Inserting a Table while Keeping an Existing Table 

Inserting a Table while Keeping an Existing Table 

While creating a new annual report from an archived report, you may want to include 
comparisons between new data and historical data already contained in the report. An easy way 
to do this is to keep a table of historical data in the report and then add an updated version of the 
same table.  

Note: In your annual report bookmarks indicate the locations of automatically inserted tables. To 
avoid unintentional changes it is recommended that you display document format marks and 
bookmarks before starting the editing process. For details see About Editing an Annual Report. 

To insert a second version of a table while keeping the existing table in the report 
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1. Open the desired annual report (see Opening an Existing Annual Report). 
2. Ensure that the Annual Reports Libraries toolbar is displayed (if necessary refer to 

Microsoft Word Help). 
3. In the report place the insertion point where you want the new table. 

Note: Ensure that the insertion point is placed outside of the bookmarks ([...]) for the 
existing table. 

4. On the Table Library menu click the name of the table you are inserting. 

Note: Ensure that the table selected in the Table Library is the same table already 
existing in the report. 

The selected table appears in the annual report. In the document any references to the old 
table are automatically changed to apply to the newly inserted table. Note that the old table 
no longer has bookmarks and any updates will be applied to the new table (see Updating a 
Table). 

  

Related Topics: 

About Annual Report Tables 

Inserting a Table 

Inserting a Table to Replace an Existing Table 

Listing Updated Clinical Trials 

In any annual report, immediately following the table of contents is the Listing of Updated Clinical 
Trials section. This section contains (or will contain) an Updated Clinical Trials table which is a 
complete list of current clinical trials related to the IND for which the report has been created. The 
Updated Clinical Trials table needs to be generated after the annual report is created and should 
be updated prior to reviewing or submitting the report. 

To generate or update the Updated Clinical Trials table 

1. On the Report Generator menu click Refresh Updated Clinical Trials Table. 

The Protocol List dialog box appears. 

Note: The Previous Year’s From Date and Previous Year’s To Date fields display the 
dates used for the most recent archived report. 

2. Type the desired dates into the From Date and To Date fields. 
3. Click Refresh List. 

All open protocols associated with the IND, and which also had a status or accrual change 
within the specified dates, are displayed and selected. If no protocols appear, then for your 
selected time period data is not available to generate a table for the report. 

4. Click Update. 

The Updated Clinical Trials table is automatically generated and inserted into your report. 

  

Related Topics: 

About Annual Report Tables 

Displaying Table Statistics 
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Moving a Table 

There are three ways to move a table from one annual report location to another. 

 Select and drag the table to a new location. Use this method when moving the table a 
short distance on a single page. 

 Cut and paste the table into a new location. Use this method for moving tables that 
have prior modifications which you do not want to lose. 

 Delete and then insert the table into a new location. Use this method to move tables 
that can be reinserted from the Table Library (prior modifications may be lost). 

After creating or opening an annual report ensure that the desired table has been generated (see 
Generating Date Parameter Tables) and then follow the appropriate steps below to move the 
table. 

  

To select and drag the table to a new location 

1. Rest the pointer on the table until the table move handle  appears at the upper-left 
corner of the table. 

2. Rest the pointer on the table move handle until a four-headed arrow appears. 
3. Drag the table to the new location. 

  

To cut and paste the table into a new location 

1. Select the table. 
2. On the Edit menu, click Cut. 
3. Place the insertion point where you want the table in the report. 
4. On the Edit menu, click Paste. 

  

To delete and then insert the table into a new location 

1. Select the table. 
2. On the Table menu, point to Delete, and then click Table. 
3. Place the insertion point where you want the table in the report. 
4. On the Table Library menu, click the name of the table. 

  

Related Topics: 

About Annual Report Tables 

Inserting a Table 

Updating a Table 

When you update a table, the Annual Reports application replaces all of the table information with 
information currently found in the Table Library. 

Note: In your annual report, bookmarks indicate the locations of automatically inserted tables. To 
avoid unintentional changes it is recommended that you display document format marks and 
bookmarks before starting the editing process. For details see About Editing an Annual Report. 

To update a table 

Note: Prior modifications made to tables having bookmarks ([...]) will be erased when the 
table is updated.  
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1. Open the desired annual report (see Opening an Existing Annual Report). 
2. Ensure that the Annual Reports Libraries toolbar is displayed (if necessary refer to 

Microsoft Word Help). 
3. Click to place the cursor in the table you want to update (be sure to click within the 

bookmarks). 

Note: If the table is without bookmarks ([...]) then the table is not linked to the Table 
Library and cannot be automatically updated per these steps. 

4. On the Table Library menu, click the name of the table. 

Note: Ensure that the table selected in the Table Library is the same as the one in which 
you have placed the insertion point. 

The existing table is replaced. 

Note: The Patient Deaths, Expedited Adverse Events, and Patient Dropouts tables require date 
parameters prior to being inserted into a report. If these tables already exist in the report and you 
want them updated then follow the steps described in Generating Date Parameter Tables. 

  

Related Topics: 

About Annual Report Tables 

Displaying Table Statistics 

Agent-Specific Adverse Events 

Following are Agent-Specific Adverse Events table specifications. 

Data source AdEERS/SMARTS, Agent Specific Adverse Event report. 

Table placement In the Adverse Events section. 

Data displayed All NSCs for the IND. 

All adverse events for the IND. 

Data breaks on Adverse Events Category. 

Cumulative data of all protocols for this IND. 

Alphabetically by Adverse Events Category. 

By protocol number. 

Categories not displayed Those with no adverse events listed. 

  

Related Topics: 

About Annual Report Tables 

Displaying Table Statistics 

DCTD, NCI-Sponsored Clinical Trials 

DCTD, NCI-Sponsored Clinical Trials table specifications. 
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Data source Protocol #:  Document number from PATS. 

Title:           Title from PATS Abstraction screens. 

Status:        Current Status from PATS. 

Date:           Current Status Date from PATS. 

Institution:    Lead Organization from PATS - Study Participants screen. 

PI:               Principal Investigator from PATS Study Participants screen. 

Data parameters Protocols are related to the IND. 

Doc. Type is P 

Current status of protocol is Active, Temporarily Closed to Accrual, 
Closed to Accrual, Temporarily Closed to Accrual and Treatment, Closed 
to Accrual and Treatment, Administratively Complete, or Complete. 

Free text fields Rationale, Objectives, Design, Patients, Results, Conclusions 

Data sort order The sort order for data in this table. 

1. Phase: Pilot, I, I/II, II, III, then Other. 
2. Single Agent Trials/Combination Agents Trials: Single Agent 

Trials are protocols with only one agent; Combination Agent trials 
are protocols with more than one agent (See PATS Study Agents 
screen). 

3. Type: (as designated in Disease Category table) Hematologic, 
then Solid Tumor. 

4. Lead disease: Lead Disease on the protocol (see PATS Study 
Diseases screen). 

Navigation feature Click the protocol number to move from the DCTD, NCI-Sponsored 
Clinical Trials table to the same protocol displayed in the IDB Clinical 
Trials Summary table or FDA Clinical Trials Summary table. 

  

Related Topics: 

About Annual Report Tables 

Displaying Table Statistics 

Expedited Adverse Events 

When the Expedited Adverse Events table is inserted automatically or selected from the Table 
Library only the bookmarked table name appears in the annual report. Either method of insertion 
requires you to then select date parameters for the table data before the table itself appears. For 
more details see Generating Date Parameter Tables. 

Expedited Adverse Events table specifications. 

Data source The AdEERS back end system Short Form. 

Data parameters Data from 13 months prior to table generation date. 

Data displayed Protocol Number 
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Ticket Number 

File/Hold 

Adverse Event/Other Specify 

Grade 

IND Agent Attribution 

Other Treatments Attribution 

Concomitant Meds Attribution 

Diseases Attribution 

Other Causes Attribution 

Data sort order Protocol Number, Ticket Number, and Grade. 

Automatic location The annual report Tables section or the Adverse Events section, 
depending on the table size. 

  

Related Topics: 

About Annual Report Tables 

Displaying Table Statistics 

FDA Clinical Trials Summary 

FDA Clinical Trials Summary table specifications. 

Data source CDUS. 

Data parameters Adverse events suffered by all patients on protocols (Doc. 
Type P) related to the IND. 

If Adverse Events have not 
been reported 

An empty row appears containing the text "Enter Adverse 
Events." This is a reminder to enter adverse events if any 
exist. 

If the monitoring method is 
NOT CDUS Complete or CTMS 

Accrual and Response values will be blank rather than "0".' 

Data displayed Protocol # / Protocol Name 

Institution / PI 

Monitoring Method 

Current Status 

Activation Date 

Cut-Off Date 

Accrual 

Response 
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Organ System 

Adverse Events Reported per Patient 

Grade 

Data sort order Phase. 

Single Agent studies, then Combination studies. 

Automatic location The annual report section titled DCTD, NCI-Sponsored 
Clinical Trials Summary Tables. This table cannot be 
inserted elsewhere. 

Navigation feature Click the protocol number to move from the FDA Clinical 
Trials Summary table to the same protocol displayed in the 
DCTD, NCI-Sponsored Clinical Trials table. 

  

Related Topics: 

About Annual Report Tables 

Displaying Table Statistics 

IDB Clinical Trials Summary 

IDB Clinical Trials Summary table specifications. 

Data source CDUS-complete monitored trials. 

Data displayed Protocol # / Protocol Name 

Institution / PI 

Current Status 

Cut-Off Date 

Patients Registered / Treated / On Study 

Activation Date 

Monitoring Method 

Planned Accrual 

Diease 

Funding Information 

Dose De-escalated 

Lead IND # 

NSC 

Total # of Courses (All Patients) 

Median # of Courses (Per Patient) 

Range # of Courses (Per Patient) 

Subgroup 
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Eval 

RR 

Treatment Assignment 

Response 

Organ System 

Adverse Events Reported (All Courses) 

Grade 

Automatic location The annual report section titled DCTD, NCI-Sponsored Clinical Trials 
Summary Tables. This table cannot be inserted elsewhere. 

Navigation feature Click the protocol number to move from the IDB Clinical Trials 
Summary table to the same protocol displayed in the DCTD, NCI-
Sponsored Clinical Trials table. 

  

Related Topics: 

About Annual Report Tables 

Displaying Table Statistics 

Most Serious Adverse Experiences in Phase 1 and 2 Trials 

Most Serious Adverse Experiences table specifications. 

Data source CDUS complete monitored trials. 

Data parameters Cumulative data for all indicated protocols on the IND. 

Data displayed Organ System 

Adverse Experience 

Total Number of Patients Treated 

 % Grade 3 

 % Grade 4 

 % Grade 5 

Adverse Events displayed Possibly, Probably, Definitely IND-related. 

Display cutoff Set at 1/5 of the highest percentage. For example, if the highest 
percent is 90, the cutoff will be any value less than 18% (1/5 of 
90 = 18). 

Percentage calculated Total number of patients on the trial divided by number of 
patients reporting the adverse event. Result multiplied by 100. 

Adverse Events sort order Greatest percentage of patients. 

Then alphabetically. 
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Automatic location The annual report Adverse Event section. 

  

Related Topics: 

About Annual Report Tables 

Displaying Table Statistics 

Most Frequent Adverse Experiences in Phase 1 and 2 Trials 

Most Frequent Adverse Experiences table specifications. 

Data source CDUS complete monitored trials. 

Data parameters Cumulative data for all CDUS-monitored protocols on the IND 

Data displayed Adverse Experience 

Organ System 

Percentage of 25 Patients 

Adverse Events displayed Possibly, Probably, Definitely IND-related. 

Percentage calculated Total number of patients on the trial divided by number of patients 
reporting the adverse event. Result multiplied by 100. 

Organ systems sort order Alphabetically. 

Adverse Events sort 
order 

Greatest percentage of patients. 

Then alphabetically. 

Automatic location The annual report Adverse Event section. 

  

Related Topics: 

About Annual Report Tables 

Displaying Table Statistics 

Non-DCTD Clinical Trials Summary 

Non-DCTD Clinical Trials Summary table specifications. 

Data source Table is populated by the user. 

References 
appearing in this 
section 

This section queries all references associated with the queried IND. A 
reference is linked to an IND via the Agent. An Agent is directly related to 
an IND. 

Each reference queried in this section has at least one disease cited in 
the reference material. 
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Categories not 
displayed 

Each reference queried in this section is not associated with a Protocol 
in the CDUS system, which would identify it as a DCTD trial. Since this 
table shows only non-DCTD trials, a reference to a Protocol relationship 
does not exist. 

Data displayed Reference/Title: Includes First Author, Year of Publication, Reference 
Title, and Article Title. 

Disease: Includes a list of all diseases cited in the reference material. 

Agent Dose/Schedule: Includes Agent Name, Dose, Unit of 
Measurement, Route—i.e., how administered, and Schedule. 

Patients Treated: Provides the number of subjects on which the test was 
conducted and for which results were collected. 

Results: Identifies the actual name of the test and the results of the 
parameters or tests  that were collected and cited in the reference 
material. 

AE Information 

 Adverse Events: Includes the list of toxicities for a specific test, 
CTC or non-CTC. 

 Grade: Displays the grade levels of adverse reactions to a 
treatment entered for an AE in the SMARTS Web application) 

 Number of Subjects: The number of subjects that experienced this 
toxicity. 

 Dose Limiting: Indicates whether this AE was dose limiting. 

  

Automatic location Follows the annual reports References section. 

  

Related Topics: 

About Annual Report Tables 

Displaying Table Statistics 

Nonclinical Studies 

Nonclinical Studies table specifications. 

Data source SMARTS 

Data parameters Reference related to agents on the IND and that have results recorded. 

References with a status of Active. 

References with the Non-Clinical Table flag set to Yes. 

Data displayed Reference/Title 

Cell Line Name/Species 

Cell Line Tissue Origin/Cell Line Type 

Exposure Time 
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Animal Model Species 

Agent/Dose Schedule 

Results 

Data sort order Alphabetically by reference author. 

Automatic 
location 

The annual report Nonclinical Studies section at end of In vivo Antitumor 
Studies subsection. 

  

Related Topics: 

About Annual Report Tables 

Displaying Table Statistics 

Patient Deaths 

When the Patient Deaths table is inserted automatically or selected from the Table Library only 
the bookmarked table name appears in the annual report. Either method of insertion requires you 
to then select date parameters for the table data before the table itself appears. For more details 
see Generating Date Parameter Tables. 

Patient Deaths table specifications. 

Data source AdEERS 

Data parameters Data from 13 months prior to table generation date. 

All Grade 5 adverse events. 

Data displayed Protocol Number 

Ticket Number 

File/Hold 

Patient ID 

Adverse Event/Other Specify 

Grade 

IND Agent Attribution 

Other Treatments Attribution 

Concomitant Meds Attribution 

Diseases Attribution 

Other Causes Attribution 

Data sort order Protocol Number, and Ticket Number. 

Automatic location The annual report Tables section or Patient Deaths section depending 
on the table size. 
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Related Topics: 

About Annual Report Tables 

Displaying Table Statistics 

Patient Demographics 

Patient Demographics table specifications. 

Data source CDUS 

Protocols not displayed Status of In Review, Withdrawn, or Approved. 

Automatic location The annual report Tables section (last table in section). 

  

Related Topics: 

About Annual Report Tables 

Displaying Table Statistics 

Patient Dropouts 

When the Patient Dropouts table is inserted automatically or selected from the Table Library only 
the bookmarked table name appears in the annual report. Either method of insertion requires you 
to then select date parameters for the table data before the table itself appears. For more details 
see Generating Date Parameter Tables. 

Patient Dropouts table specifications. 

Data source CDUS - Patient Dropout report. 

Data parameters Only patients on protocols (Doc. Type P) related to the IND. 

Patients are off the study. 

Off Treatment Reason does not equal Treatment Completed per Protocol. 

Patient's last treatment was within the dates specified. 

Does not include patients who took two or more courses and for whom the 
Off Treatment Reason is Disease progression or relapse during treatment. 

Data displayed Protocol Number 

Patient ID 

Course Number 

Off Treatment Reason 

Data sort order Phase, and Protocol Number. 

Automatic 
location 

The annual reports Patient Dropouts section. 

  



31 

 

Related Topics: 

About Annual Report Tables 

Displaying Table Statistics 

Updated Clinical Trials 

When the Updated Clinical Trials table is inserted automatically or selected from the Table Library 
only the bookmarked table name appears in the annual report. Either method of insertion requires 
you to then select date parameters for the table data before the table itself appears. For more 
details see Listing Updated Clinical Trials. 

Updated Clinical Trials table specifications. 

Data source Protocol #:     Document number from PATS. 

Status:          Current Status from PATS. 

Date:             Current Status Date from PATS. 

Institution:      Lead Organization from PATS - Study Participants 
screen. 

Title:              Title from PATS Abstraction screens. 

Accrual Now:  Total number of patients accrued as of the From Date. 

Accrual Goal:  Estimated Accruals calculated by the number of months 
between study activation date and max patient collection 
date, multiplied by the patient accrual rate (from PATS 
Study Accruals). 

Page Txt:       DCTD, NCI-SPONSORED CLINICAL TRIALS page 
number from which the protocol is referenced. 

Page Tbl:       IDB/FDA Tables page number from which the protocol is 
referenced. 

Protocols displayed 
and highlighted for 
selection 

Related to the IND. 

Status change within the specified date range. 

Accrual change within the specified date range. 

Protocols displayed 
but not highlighted 
for selection 

Related to the IND. 

Open protocols without a status or accrual change within the specified 
date range and the Current Status is Active, Temporarily Closed to 
Accrual, Closed to Accrual, Temporarily Closed to Accrual and 
Treatment, Closed to Accrual and Treatment. 

Open protocols without a status or accrual change within the specified 
date range and the Current Status is Complete or Administratively 
Complete within the three years prior to the specified From Date. 

Protocols not 
displayed 

Protocols with status of In Review, Withdrawn, or Approved. 

Data parameters Data which has changed within the specified date range. 
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Data displayed Protocol Number Status/Date 

Investigator 

Title 

Accrual 

 Actual 

 Planned 

Page Number Txt/Tbl 

Protocols sorted 
under each Phase 

Type within the Disease Category. Types include Solid Tumor and 
Hematologic.  

Within each type, protocols are sorted by lead disease. 

Abbreviations The following abbreviations describe the protocol status. 

AC = Active 
CP = Complete 
CL-A = Closed to Accrual 
CL-B = Closed to Accrual and Treatment 
TC = Temporarily Closed 
TC-A = Temporarily Closed to Accrual 
TC-B = Temporarily Closed to Accrual and Treatment 

  

Related Topics: 

About Annual Report Tables 

Displaying Table Statistics 

About Editing Text in an Annual Report 

When you create a draft annual report sections appear without textual content which you must 
then provide. Some sections also require you to answer questions or select one of several 
choices of automatically inserted textual content. Therefore, before the draft annual report is 
ready to be completed and sent you must edit the report ensuring that the textual content 
represents the correct information. 

You can edit the textual content of an annual report directly by using a combination of Word tools 
and tools provided by the Annual Reports application for this specific purpose. For more 
information see the Related Topics below. 

Note: To avoid unintentional changes it is recommended that you display document format marks 
and bookmarks before starting the editing process. For details see About Editing an Annual 
Report. 

  

Related Topics: 

Inserting Text from the Data Library 

Changing Data Library text in an Annual Report 

Working with Blue-Colored Text 

Working with Green-Colored Text 
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Working with Error Messages 

Changing Annual Report Data Library Text 

Information used repeatedly in annual reports is stored in the Data Library. The information stored 
in the Data Library cannot be changed directly. Once Data Library information has been inserted 
into a report you can change the text by using the Edit Tag Values command. 

For example, IND Title is Data Library information that may appear many times in an annual 
report. If you decide to change the way the IND Title appears (spacing, capitalization, spelling, 
etc.), the Edit Tag Values command enables you to make the change once so that the same 
change appears at all other locations in the report where the IND Title was inserted from the Data 
Library. 

Note:  Edit Tag Values changes apply only to Data Library items that already exist in the report. 
The original text of the Data Library item remains unchanged in other reports and when inserted 
later. Typed information that duplicates the Data Library item also remains unchanged. 

To change Data Library text in an annual report 

1. Open the desired annual report (see Opening an Existing Annual Report). 
2. On the Report Generator menu, click Edit Tag Values. 

The Edit Tag Values dialog box appears. 

3. In the Select Data Tag field, enter the name of the Data Library item you want to change. 
4. In the Data Tag Value field, edit the text as you want it displayed in the annual report. 
5. Click Update. 

The system updates the text of the Data Library item throughout the report. 

Note: Changes to Data Library text that have been made using these instructions will be undone 
if the report is later updated. For this reason, changing Data Library text in a report should only be 
done after all automated edits have been made and the report is being completed for submission. 

  

Related Topics: 

About Editing Text in an Annual Report 

About Completing an Annual Report 

Inserting Data Library Text 

Information used repeatedly in annual reports is stored in the Data Library. In addition to it's 
textual content the information often contains bookmarks and fields which present data such as 
IND or Agent identification that can be automatically updated after completion of the report. 
Although often incorporated automatically into an annual report the Data Library information is 
accessible from the Annual Reports Library toolbar so that you can select and insert any desired 
additional information. 

Inserting this information from the Data Library ensures that the text is correct and represented 
consistently throughout the report. Inserting text from the Data Library also makes it easy to 
change the text later (see Changing Annual Repot Data Library Text). 

To insert text from the Data Library 

1. Open the desired annual report (see Opening an Existing Annual Report). 
2. Ensure that the Annual Reports Libraries toolbar is displayed (if necessary refer to 

Microsoft Word Help). 
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3. In the annual report document place the insertion point where you want to insert the Data 
Library information. 

4. On the Data Library menu, click the name of the desired information. 

The selected information appears in the annual report. 

  

Related Topics: 

About Editing Text in an Annual Report 

Updating Data Library Text 

In the Annual Reports application, information available in the Data Library is updated to stay 
current. These updates are not automatically incorporated into any Data Library text or fields that 
have already been inserted into currently existing annual reports. The Update Data Fields 
command is provided for you to do this when necessary. 

Note: Previous Data Library text changes made directly in an annual report (see Changing 
Annual Report Data Library Text) will be undone when the Update Data Fields command is 
used.  

To update Data Library text in an annual report 

1. Open the desired annual report (see Opening an Existing Annual Report). 
2. On the Report Generator menu, click Update Data Fields. 
3. Save the report.  

  

Related Topics: 

About Editing Text in an Annual Report 

Working with Blue-Colored Text 

Blue colored text is automatically inserted into an annual report to provide you with the option of 
selecting from two or more versions of textual content each of which contain different information. 
Each text choice is separated by the word OR. You must delete the text that is not appropriate 
and then change the color of the remaining text. 

When you discover blue-colored text in your annual report perform the following steps. 

1. Determine which of the blocks of blue text you want to delete. 
2. Select the text you want to delete (and the "OR") and then press DELETE. 
3. Select the blue text you elected to keep. 
4. On the Format menu, click Font. 

The Font dialog box appears. 

5. In the Font color list, click Automatic and then click OK. 
6. Save the report. 

Note: If an error message is contained in the text you decided to keep see Working with Error 
Messages. 

  

Related Topics: 

About Editing Text in an Annual Report 
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Working with Green-Colored Text 

Green colored text in a grey background is an automatically inserted field asking you to type 
specific information that is necessary for the annual report. An example of this is: [Click here and 
type the company name]. 

When you discover green colored text in your annual report perform the following steps. 

1. Place the insertion point in the green text. 

The entire field becomes highlighted. 

2. Type the requested information. 

The field disappears and is replaced by your typed text although the text color is still green. 

3. Select the green text you just typed. 
4. On the Format menu, click Font. 

The Font dialog box appears. 

5. In the Font color list, click Automatic and then click OK. 
6. Save the report. 

  

Related Topics: 

About Editing Text in an Annual Report 

About Completing an Annual Report 

There are a number of tasks that are better performed after you have created and edited your 
annual report and just prior to report submittal or archiving. The following table lists these tasks in 
the recommended order of performance. 

  

Show 
Formatting 
Marks 

Formatting marks, bookmarks, and fields must be displayed to complete 
these tasks. To do this see About Editing an Annual Report. 

Change Data 
Library Text 

Make any desired changes to automatically inserted Data Library text. To do 
this see Changing Annual Report Data Library Text. 

Remove Page 
Breaks 

Remove any unnecessary page breaks that may have been created during 
the editing process. To do this see Using Page and Section Breaks. 

Review Table 
Placement 

Check all tables in your report to ensure that columns and rows have been 
resized appropriately to fit their contents, if necessary. Ensure that none of 
the tables break needlessly across pages. Adjust page breaks if necessary 
(see Using Page and Section Breaks). 

Check Spelling Use the automatic spell-checking capability provided by Microsoft Word. To 
do this, press F7. 

Update the 
Table of 
Contents 

Ensure that your report's Table of Contents correctly displays the 
appropriate items and associated page numbers by following the steps 
described in Updating the Table of Contents. 
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Highlight 
Changes 

If your report has been created from an archived annual report and you want 
to display the differences between the two reports then follow the steps 
described in Highlighting Annual Report Changes. 

  

Highlighting Annual Report Changes 

When you create a new annual report by using an archived annual report you can highlight the 
differences between last year's report and this year's report. This should be the last thing done to 
the annual report before it is submitted and archived. 

NOTE: This function will only work on a report created from an archived annual report (see 
Creating an Annual Report from an Archived Annual Report).  

To highlight the differences between last year's report and this year's report then, while the new 
annual report is open, on the Report Generator menu, click Highlight Changes.  

NOTE: If a difference exists in a single table cell between this year's and last year's annual 
reports, the application will highlight the entire row in which the cell resides. In all cases where an 
entire row of a table is highlighted, you may want to compare the two reports and remove 
highlighting from cells that have not changed. 

  

Related Topics: 

About Completing an Annual Report 

About Annual Report Tables 

Saving an Annual Report 

While working on an annual report save the document often to avoid the risk of accidentally losing 
completed work. 

To save your annual report, on the File menu, click Save. 

NOTE: If this is the first time you are saving the annual report, Word will display the Save As 
dialog box. When this occurs select the path of where the annual report is to be stored, assign a 
name to the report, then click Save. 

Updating the Table of Contents 

While editing your annual report the page numbers are automatically updated. Unfortunately, 
when this occurs the Table of Contents may become out of sync with the updated page numbers. 
Additionally, the Table of Contents will not reflect any section title changes (such as additions or 
deletions). After all changes have been made and you are ready to stop work on the annual 
report, you should make a final update to the Table of Contents. 

To update the table of contents of an open annual report, on the Report Generator menu click 
Update TOC and Paginate. 

NOTE: To update the Table of Contents, the application searches for all occurrences of 
Heading1-style text. For each instance of Heading1-style text, the application inserts an entry in 
the Table of Contents matching the heading and its location page number. Because of this, if you 
manually add (without using the Section Library) a section to the annual report, ensure that you 
apply Heading1-style formatting to the section heading. 
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Related Topics: 

About Completing an Annual Report 

Archiving an Annual Report 

After an annual report has been completed and then reviewed by IDB for final approval, the report 
should be archived prior to FDA submittal. Archiving the report ensures that a permanent record 
of the submitted report is retained and available for use as the basis for the following year's 
annual report. 

NOTE: Only archive a report that is complete and ready for submittal. 

To archive an annual report 

1. On the Annual Reports window, click Archive Annual Reports to display the Archive 
Report screen. 

2. In the IND # field, enter the number identifying the IND contained in the report you want to 
archive. 

3. At the end of the File to Archive field, click the Open button.  
4. In the Open dialog box, find and select the annual report document. 

The path of the selected document appears in the File to Archive field. 

5. In the Version Date field, enter the appropriate date. 
6. In the Sent To field, ensure that the appropriate value (FDA or IDB) is selected. 
7. In the Version Type field, ensure that the appropriate value (Original or Amendment) is 

selected. 
8. If your selected Version Type is Amendment, then in the Original Version field, select the 

annual report document you are amending. 
9. Type additional information into the Comments field. 
10. Click Save. 

Note: To return to the Annual Reports window click the Close button.   

Add New Section Template 

The Add New Section Template command enables you to create new annual report section 
templates (section documents).  

Add New Section Template is found on the Administrator menu located on the Word toolbar. 
Click Add New Section Template and a blank Word document opens with the tool bar changed 
to display the following Annual Reports menus. 

Section Generator 

Data Library 

Table Library  

Special Library  

  

Related Topics: 

Creating a Section Template 
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Annual Reports Help 

To access SMARTS AR (Annual Reports) Help at any time choose the Annual Reports Help 
command on the Report Generator menu located on the Word toolbar. 

  

Related Topics: 

Welcome to SMARTS Annual Reports Help 

Annual Reports Wizard 

If you want to create, edit, or review an annual report in addition to a report you already have 
open then choose the Annual Reports Wizard command on the Report Generator menu 
located on the Word toolbar. The Annual Reports Wizard will appear. 

  

Related Topics: 

Creating an Annual Report by Using the Wizard 

Archive Annual Reports 

Located on the Annual Reports window, choose the Archive Annual Reports command to 
open the Archive Report screen which enables you to select and archive an annual report. 

  

Related Topics: 

Archiving an Annual Report 

Assign IND 

The Assign IND command enables you to select an IND and then assign it to an annual report. 
Located on the Report Generator menu, when you choose Assign IND the Assign IND to 
Document dialog box appears. 

  

Related Topics: 

Creating an Annual Report from a Similar Annual Report 

Cancel 

Closes a screen area or dialog block without saving modifications performed since the last save.  

  

Related Topics: 

  

Cancel Query 

The Cancel Query command  enables you to end any currently existing query effort 
displayed on the screen. 
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Edit 

Opens the annual report section template document identified in the Choose Section to Edit 
field. 

Located on the Edit Section dialog box (see Edit Section Template) click Edit and the Word 
document containing the identified section template opens. 

  

Related Topics: 

Editing a Section Template 

Edit Section Template 

The Edit Section Template command enables you to open and edit existing annual report 
section templates (section documents). 

Edit Section Template is found on the Administrator menu located on the Word toolbar. Click 
Edit Section Template and an Edit Section dialog box appears. 

  

Related Topics: 

Editing a Section Template 

Edit Tag Values 

The text of specific Data Library items inserted into an annual report can be changed using the 
Edit Tag Values command. When a Data Library item is changed using Edit Tag Values the 
same change appears where ever that Data Library item had been inserted into the report. 

Located on the Report Generator menu (on the Word toolbar), click Edit Tag Values and the 
Edit Tag Values dialog box appears. For more details see Changing Annual Report Data Library 
Text. 

  

Related Topics: 

About Editing Text in an Annual Report 

Enter Query 

The Enter Query command  enables you to enter on the screen information upon which a 
query is to be conducted.  

Enter Table Dates 

The Enter Table Dates command enables you select new or change existing date parameters for 
tables in a currently open annual report. 
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On the Report Generator menu, click Enter  Table Dates, and the Table Dates dialog box 
appears. 

  

Related Topics: 

Generating Date Parameter Tables 

Execute Query 

The Execute Query command  initiates a query based on information you've entered or 
selected on the screen.  

Hide/Show Bookmarks 

Bookmarks mark the location of tables or text that are automatically placed within an annual 
report document. The Hide/Show Bookmarks command enables you to see or not see the 
bookmarks in a document. For more details see About Editing an Annual Report. 

With an open annual report document, on the Options menu click Show/Hide Bookmarks.  

  

Related Topics: 

About Completing an Annual Report 

Highlight Changes 

While creating a new annual report from an archived annual report the Highlight Changes 
command enables you to identify where differences exist between the new and archived annual 
report. Located on the Report Generator menu, click Highlight Changes and a copy of the new 
report will appear with the change locations highlighted. 

  

Related Topics: 

Highlighting Annual Report Changes 

Next Record 

The Next Record command  displays the next sequential data record occurring later then 
what's displayed in the line or field where the insertion point is currently located.  

Open 

The Open command enables you to select and open an annual report document.  

Click the Open button  and then in the Open dialog box find and select the desired annual 
report document. The path of the selected document appears in the field adjacent to the Open 
button.. 

  

Related Topics: 



41 

 

Archiving an Annual Report 

Creating an Annual Report from a Similar Annual Report 

Previous Record 

The Previous Record command  displays the next sequential data record occurring earlier 
then what's displayed in the line or field where the insertion point is currently located.  

Refresh List 

When generating or updating an Updated Clinical Trials table displayed in an annual report, the 
Refresh List command is used to find protocols associated with the report's IND's in a specified 
time period. 

In the Protocol List dialog box (see Listing Updated Clinical Trials), after selecting the dates for 
the desired time period, click Refresh List and all appropriate protocols are displayed.  

  

Related Topics: 

About Annual Report Tables 

Refresh Updated Clinical Trials Table 

Each annual report displays a list of clinical trials related to IND's identified in the report. Located 
in the Listing of Updated Clinical Trials section of an annual report, the list is displayed in the 
Updated Clinical Trials table. The Refresh Updated Clinical Trials Table command enables you 
to generate or refresh the Updated Clinical Trials table. 

After creating or opening an annual report, from the Report Generator menu, choose Refresh 
Updated Clinical Trials Table. The Protocol List dialog box appears. For more details see 
Listing Updated Clinical Trials. 

  

Related Topics: 

About Annual Report Tables 

Report Statistics 

After opening an annual report, use the Report Statistics command to see the time and date that 
all tables or special sections were last updated by the application. 

Click Report Statistics and an Annual Report Statistics dialog box appears. To return to the 

report click the Close button.  

  

Related Topics: 
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Save Section to Database 

To save an annual report section template you have created or edited choose the Save Section 
to Database command on the Section Generator menu located on the Word toolbar. The Save 
Section dialog box appears (for details see Creating a Section Template). 

  

Related Topics: 

Creating a Section Template 

Editing a Section Template 

Trial Designation 

Located on the Annual Reports window, choose the Trial Designation command to open the 
Protocol Trial Type Maintenance screen which enables you to assign protocol trial types. 

  

Related Topics: 

Designating Protocol Trial Types 

Update 

The Update command is used to automatically incorporate tag value changes or date parameters 
at all locations where the effected items (text or tables) appear in a currently open annual report. 

  

The Update command is also used to automatically generate or update an Updated Clinical 
Trials table by incorporating a selected list of protocols into the table.  

Located on the Protocol List dialog box (see Listing Updated Clinical Trials), click Update and 
all selected protocols are incorporated into the Updated Clinical Trials table in a currently open 
annual report.  

  

Related Topics: 

Changing Annual Report Data Library Text 

Generating Date Parameter Tables 

Update Data Fields 

When the Update Data Fields command is used on an open annual report, externally updated 
Data Library information is automatically incorporated into any Data Library text or fields that have 
already been inserted into the report.  

Note: Previous Data Library text changes made directly in an annual report (see Changing 
Annual Report Data Library Text) will be undone when the Update Data Fields command is 
used.  

  

Related Topics: 

Updating Data Library Text 
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Update TOC and Paginate 

The Update TOC and Paginate command ensures that the Table of Contents for an annual 
report is updated to reflect any changes made to the document, and that each page is correctly 
numbered. 

  

Related Topics: 

Updating the Table of Contents 

Choose Section to Edit 

The Choose Section to Edit field is used to identify a specific annual report section template that 
you want to open for editing.  

Located on the Edit Section dialog box (see Edit Section Template) type the desired section 
template name into the Choose Section to Edit field or select it from drop down list.  

  

Related Topics: 

Editing a Section Template 

Comments 

The Comments field is provided for you to add additional information concerning an associated 
record. To add information select the Comments field and type. 

  

Related Topics: 

Archiving an Annual Report 

Data Tag Value 

The text of a selected Data Library item is displayed for editing in the Data Tag Value field. In the 
Data Tag Value field edit the text as you want it displayed in an annual report. 

  

Related Topics: 

Changing Annual Report Data Library Text 

Display Name 

The section name which is displayed in the annual report to identify the section's location prior to 
report generation. In the Display Name field, type the name of the section. 

  

Related Topics: 

Creating a Section Template 

Editing a Section Template 
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Document Name 

The file name for the Word document containing the annual report section template you are 
creating or editing. In the Document Name field, type the desired file name for the new section 
template (because this is a Word document include .doc).  

  

Related Topics: 

Creating a Section Template 

File to Archive 

The document name and file path of an annual report to be archived. 

Click the Open button  located at the end of the File to Archive field, and then select the 
desired annual report document. The path of the selected document then appears in the File to 
Archive field. 

  

Related Topics: 

Archiving an Annual Report 

IND # 

The identification number of the Investigational New Drug (IND) described in an annual report you 
want to archive. Type (10 characters maximum) or select the desired IND number from the IND # 
field list of values. 

  

Related Topics: 

Archiving an Annual Report 

IND Number 

The identification number of an Investigational New Drug (IND) that you intend to query on the 
Protocol Trial Type Maintenance screen. 

  

Related Topics: 

Designating Protocol Trial Types 

  

IND Prefix 

Additional identification characters integrated into IND Numbers that you intend to query on the 
Protocol Trial Type Maintenance screen. 

  

Related Topics: 

Designating Protocol Trial Types 
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IND Status 

The IND Status field displays the current status of a selected IND. On the Annual Report 
Wizard, when a value is entered into the Select an IND field, the IND Status field automatically 
populates  

  

Related Topics: 

Creating an Annual Report by Using the Wizard 

IND Title 

The IND Title field displays the name of a selected IND (Investigative New Drug). On the Assign 
IND to Document dialog box when a value is entered into the Select an IND field, the IND Title 
field automatically populates  

  

Related Topics: 

Creating an Annual Report from a Similar Annual Report 

Insert After 

The name of the section which you want preceding a newly created section in the Annual 
Reports Wizard list of sections. In the Insert After field, type or select the desired section name. 

  

Related Topics: 

Creating a Section Template 

Editing a Section Template 

Original Version 

Identifies the annual report document for which you are archiving an amended version. Select the 
desired annual report document from the Original Version field list of values . 

Note: The Original Version field is only enabled when a Version Type value of Amendment has 
been previously selected.  

  

Related Topics: 

Archiving an Annual Report 

Select an IND 

The identification number of a desired IND. Type the IND number into the Select an IND field, or 
select it from the drop-down list. 

  

Related Topics: 
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Creating an Annual Report by Using the Wizard 

Select Data Tag 

A specific Data Library item that you want to edit is identified in the Select Data Tag field. In the 
Select Data Tag field, type or select the name of the desired Data Library item. 

  

Related Topics: 

Changing Annual Report Data Library Text 

Select Sections 

The Select Sections field is pre-populated with a list of annual report sections available for 
inclusion in an annual report. Some sections are automatically selected based on whether or not 
the IND, for which the report is being created, is a biologic or chemotherapeutic. In the Select 
Sections field, ensure that the name of those sections you want to appear in the report are 
selected. 

  

Related Topics: 

Creating an Annual Report by Using the Wizard 

Sent To 

Identification of the recipient of an archived annual report. Select either FDA or IDB from the Sent 
To field drop-down list. 

  

Related Topics: 

Archiving an Annual Report 

Version 

The version identification automatically assigned to document sections. 

  

Related Topics: 

Creating a Section Template 

Version Date 

A date you select for a report you are archiving. It is recommended that you use the FDA or IDB 
submittal date.  

Type (mm/dd/yyyy format) or select the appropriate date from the Version Date field list of 
values. 

  

Related Topics: 

Archiving an Annual Report 
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Version Type 

Identifies an archived annual report document as either the Original or an Amendment to a 
previously archived annual report. Select either Original or Amendment from the Version Type 
field drop-down list. 

Note: Selecting Amendment enables the Original Version field and you must then select the 
annual report document you are amending. 

  

Related Topics: 

Archiving an Annual Report 

Trial Type 

Indicates whether a protocol trial involves a single agent or a combination of multiple agents. 
Type the appropriate value into the Trial Type field, or select it from the drop-down list. 

  

Related Topics: 

Designating Protocol Trial Types  

Administration 

Appearing on the Word toolbar when creating or editing an annual report the Administration 
menu contains the following commands. 

 Add New Section Template 

 Edit Section Template 

  

Related Topics: 

Creating a Section Template 

Editing a Section Template 

Data Library 

Appearing on the Word toolbar when creating or editing an annual report the Data Library menu 
contains a collection of textually formatted information that you can select and insert into the 
report. 

  

Related Topics: 

Inserting Data Library Text 

Options 

Appearing on the Word toolbar when creating or editing an annual report the Option menu 
contains the following commands. 

 Hide/Show Bookmarks 

 Report Statistics 
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Related Topics: 

About Creating Annual Reports 

About Editing an Annual Report 

Report Generator 

Appearing on the Word toolbar when creating or editing an annual report the Report Generator 
menu contains the following commands. 

 Annual Reports Wizard 

 Assign IND 

 Edit Tag Values 

 Update Data Fields 

 Update TOC and Paginate 

 Refresh Updated Clinical Trials Table 

 Enter Table Dates 

 Highlight Changes 

 Annual Reports Help 

  

Related Topics: 

About Creating Annual Reports 

About Editing an Annual Report 

Section Generator 

Appearing on the Word toolbar when creating a new annual report section template or editing an 
existing section template the Section Generator menu contains the following command. 

 Save Section to Database 

  

Related Topics: 

Creating a Section Template 

Editing a Section Template 

Section Library 

Appearing on the Word toolbar when creating or editing an annual report, the Section Library 
menu contains a collection of named report text and table sections that you can select and insert 
into the report. 

Note: Some Section Library menu commands used to insert named table sections do not 
include the table. If necessary, after selecting a table section, select the appropriate table from 
the Table Library. 

  

Related Topics: 

Adding an Annual Report Section 



49 

 

Special Library 

Appearing on the Word toolbar when creating or editing an annual report the Special Library 
menu contains commands that enable you to insert specially formatted information. The following 
information can be selected from the Special Library menu. 

 DCTD NCI Sponsored Clinical Trials 

 FDA Clinical Trials Summary 

Although commands with the same name appear in the Section Library menu, the information 
represented by these Special Library commands is not formatted to create separate report 
sections. 

  

Related Topics: 

About Creating Annual Reports 

About Editing an Annual Report 

Table Library 

Appearing on the Word toolbar when creating or editing an annual report the Table Library menu 
contains a collection of tables that you can select and insert into the report. 

  

Related Topics: 

Inserting a Table 

Inserting a Table to Replace an Existing Table 

Inserting a Table while Keeping an Existing Table 

Updating a Table 

Create New 

When you want to create a new annual report or section template choose the Create New option 
located on the Annual Reports window. 

  

Related Topics: 

Creating a Section Template 

Editing a Section Template 

Creating an Annual Report by Using the Wizard 

Creating an Annual Report from an Archived Annual Report 

Creating an Annual Report without Using the Wizard 

First/Subsequent Queried Section 

Refers to the sequential order in which a section is queried when the document is searched. 

  

Related Topics: 
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Creating a Section Template 

Format 

Indicate in the Format area whether a new section must be displayed on a page in a portrait or 
landscape orientation. Generally the decision is dependent upon the configuration of tables 
contained within the section. In the Format area click either the Portrait or the Landscape 
option. 

  

Related Topics: 

Creating a Section Template 

Editing a Section Template 

Open Existing 

When you want to open and review or edit an existing annual report choose the Open Existing 
option located on the Annual Reports window.  

After choosing Open Existing, you must identify in the adjacent field the document name and file 

path of the desired report. Type or select this information by clicking the Open button.  

  

Related Topics: 

Creating an Annual Report from a Similar Annual Report 

Type 

Determine what type of IND a new section must be made available for, and then indicate this in 
the Type area. In the Type area click one of the following options. 

 Biologic 

 Chemo 

 Neither 

 Both 

  

Related Topics: 

Creating a Section Template 

Editing a Section Template 


